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Calendar

View by day, week or month; set Alarms for events.

I Opening Calendar

Main Menu p> Tools p> Calendar

Current month appears.

® \When a date with Calendar events is selected,
number of AM and PM events and up to three
contents appear.

@ Press (@)[Prev.] or (a)[Next] to show
previous/next month calendar.

® To switch Monthly/Weekly view: C%P.13-4

2010/ 2/ 5(Fri)
Sun Mon Tue Wed Thu Fri Sat

11 2] 3 4E8) 6
7| 8 9/10 1112 13

14/ 15 16/ 17| 18| 19| 20

21| 22| 23| 24 25 26 27

28

2 @0 |
©11:35 Scheduled
2511:40 Shopping

I Creating Calendar Events
Save up to 1000 entries.

Main Menu p> Tools p» Calendar

#34 to highlight a date — i _Edit schedule
lScheduled (No Title)
[NEW] — Schedule >Locat ion
@Whole day OF
©Date (from)
2010/ 2/°5 10:10
@Date (to)
2010/ 2/ 5 10:10
CORepeat F
EAlarm OFF|
ATone Clock Alarm Tonel
[“Contents

2 Select an item (See below)

Item Operation/Description

1112:30 Meal

-

(e |
e
Monthly View

Selecticon/ > Select an icon = Edit subject
Edit summary

Edit location > Enter location

Whole day > OFF or ON
setting ® When ON is set, Alarm goes off at 0:00 a.m.

Date (from) > Enter start date and time
Date (to) > Enter end date and time

Repeat > Select a repeat type = (For Select day, check days
- (=)[Finish])
Alarm > Select an Alarm type (= For ON/Set time, enter time)

® Alarm Tone: [%P.13-6

Alarm tone > Select an Alarm tone type = Select a folder = Select
an Alarm tone

Contents > Enter event description




3 (=[Finish]

Calendar Event Indicators

Following indicators appear in Calendar Window.

[l (Blue): Momning event

[l (Orange): Afternoon event

__ (Underscore): Event that lasts for two days or longer

® Following indicators appear on Display.

:Alarm @ : Monthly
I3 : Daily K4 : Yearly
W : Weekly

® Calendar events between 00:00 on 2000/01/01 and 23:59 on
2037/12/31 can be saved on handset.

® Alarm tone does not sound when Privacy Key Lock or Personal Data
Lock is set. However, settings can be changed even while Personal Data
Lock is set (C%P.12-6).

ISaving Holidays/Memorial Days

Save up to 100 entries (one entry a day) each for Holidays
or Memorial days.

Main Menu » Tools p> Calendar

1 (Highlight a date =) (=2)[New] - Holidays or
Memorial days

2 Select an item (See below)

Item Operation/Description
Date setting > Enter a date

Repeat > Select a repeat type
® 7 time does not repeat Holidays/Memorial days
events.
Edit holiday/ > Enter description
anniversary
g

3 ([Finish] =
Indicators

Holidays appear in red.
Memorial days are marked with a red circle.

® Following indicators appear in Calendar/Calendar Event List Window:
% :Holidays  / : Memorial days : Yearly repeat
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IViewing/Editing Calendar Event Details

Main Menu » Tools p> Calendar
1 B39 toselect adate

Select an event

Detailed schedule appears.

® To edit: (@)[Edit] — Edit selected item
(Schedule: % From Step 2 on P.13-2/
Holiday, Anniversary: Z%From Step 2 on
P13-3)

I Calendar Functions

& 2010/ 2/ 5(Fri)

&Shopping
E112:30~13:00
fiMeal

Calendar Event List

Q Summary

Scheduled
@Whole day OFF|
@Date (from)

2010/ 2/ 5(Fri) 11:35
@Date(to)

2010/ 2/ 5(Fri) 11:35
CORepeat OFF|
[EAlarm OFF|
[“Contents

Scheduled

Calendar Event Details

(From Jp Main Menu b Tools p> Calendar

M Functions Available in Calendar Window
> Highlight a date = (¥7)[Menu] — Select an item (See below)

Item

Operation/Description

New

Create a new entry (C%¥P.13-2, P.13-3)

Item Operation/Description
Weekly Toggle Monthly/Weekly view
display/
1 Month

Icon display

Entries in category of selected icon appear
> Select an icon

No. of Display number of saved Schedule, Holiday or Anniversary

schedules entries

Add shortcut Create a shortcut (C%P.1-25)

icon

Send all Ir (¥P.11-3)

data

AlliIC (C%P.11-5)

transmission

Delete past  Delete past entries/items, prior to highlighted date
> Select a category to delete = YES

Delete all > Enter Phone Password = Select an item = YES

Reset Restore deleted Holidays

holidays >YES

M Functions Available in Calendar Events List/Details
> Select a date (= Select a Schedule, Holiday or Anniversary) =
(x[Menu] — Select an item (See below)

Item Operation/Description
New Create a new entry (C%P.13-2, P.13-3)
Edit Edit selected item (% Left)
Copy Copy an entry to another day
> Enter date and time to copy an entry to
Calendar Switch from Icon display to Calendar display
display




Item Operation/Description TaSkS
Icon display E>m2:|2cl? ;stii%(;ry of selected icon appear Make quick notes of task to manage in Task list.
Set secret Activate/deactivate Secret Mode o
mode/ > YES (= For Set secret mode, enter Phone Password) I Savmg a Task
Release ® Secret entries appear only in Secret Mode or .
secret Secret Data 0nly (\'f?P.12-10). Main Menu p» Tools | 2 Tasks
;ZTSZ‘;? Isrlzzrtzec\)/ﬁn; 1dj_t:la)and details to message text (C¥From 1 [New] - Select an item (See below)
Send Ir data  (C5P.11-3) ° Tg check saved Tasks, select a Task. To edit, press (@)[Edit] in detail
Sendalllr  (C7P11-3) window.
data Item Operation/Description
IC (©%P.11-5) Edit Tasks > Enter content
transmission Due date > Select how to enter due date —= Enter due date
AlliC C%P.11-5) ® Select No date to enter none.
transmission Priority > Select a priority level
Copy to Copy an entry to microSD Card Category > Select a category
microSD > YES Alarm > Select an Alarm type (= For ON/Set time, enter time)
® To display data on microSD Card: £%P.10-20 @ Alarm Tone: £%P.13-6
Delete this > YES Alarm tone > Select an Alarm tone type = Select a folder =
Delete past  Delete past entries/items, prior to highlighted date Select an Alarm tone

> Select a category to delete = YES

Delete select

> Check entries to delete = (=)[Finish] - YES

y (&)[Finish]

® When content is not entered, Tasks cannot be saved.

@ Alarm tone does not sound when Privacy Key Lock or Personal Data
Lock is set. However, settings can be changed even while Personal Data
Lock is set (C%P.12-6).
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I Using Tasks

In Tasks window, press (x7[Menu] for following operations.

Item Operation/Description
New Create a new entry (C%P.13-5)
Edit Edit an entry (C%P.13-5)
Change Change status indicator shown in Tasks list
status > Select a status (= For Completion, select an item —
Enter Completion date)
@ Overdue status indicator turns red.
Show by > Select a category
category

Sort/Filter Sort list by due date, entry order, status, etc.

> Select a condition

Add shortcut Create a shortcut (£%P.1-25)

icon
Send Ir data (C%P.11-3)
Send all Ir *P11-3)
data
IC transmission (C%P.11-5)
AlliC (%P.11-5)
transmission
Copy to Copy a Task to microSD Card
microSD >YES
® To display data on microSD Card: £3P.10-20
Delete this > YES

Delete select > Check entries = (=)[Finish] - YES

Delete Delete an entry in Completion status
completed > VYES
Delete all > Enter Phone Password = YES

Alarms
IAIarm Tone

When scheduled time arrives, alarm tone sounds and

Notification Light illuminates.

® For Calendar events and Tasks, alarm message and animation
corresponding to selected icon appear on Display.

To Stop Alarm Tone for Calendar Events, Tasks or Alarm
Press any key.

Missed Alarm

"Missed alarm" Event Indicator appears in Standby for alarms missed
during Privacy Key Lock, Personal Data Lock or Infrared transmission once
locks are canceled or transmission ends. Select indicator to view content.

@ When one or more Alarms are set to the same time, alarm sounds in
the order of : "Alarm" = "Timer Recording" = "Tasks" = "Calendar"
- "Timer Watching"

For Tasks, "Missed alarm” indicator appears.

@ [f alarms are set for more than one Calendar event, press (x7)[Next]

when alarm sounds to toggle Calendar event entries.




I Setting Alarm

Set up to 12 alarms. Alarm tone sounds at the specified time
once, everyday or weekly as set.
@ {3 appears in Standby when Alarm is set.

Main Menu p> Tools p> Alarms
1 Highlight an Alarm — (=)[Edit]

[ Edit Alarm clockl
O ———

@Prefer manner mode ON

2 Select an item (See below)

Item Operation/Description
Alarm Activate or cancel Alarm
> ON or OFF
Time > Set Alarm time
Repeat > Select a repeat type (—= For Select day, check days =
(=)[Finish])
Tone > Select an Alarm tone type = Select a folder =
Select an Alarm tone
Volume > (B to set Alarm tone volume
Snooze When Snooze is set to ON, Alarm tone sounds for 60
seconds, repeating up to six times at five minute intervals.
> ON or OFF (= For OFF, enter time)
Prefer Set Manner Mode or Alarm priority.

manner mode > ON or OFF

3 (=[Finish]

Alarm Indicators
@ Following indicators appear:

I : Repeats daily : Repeats weekly

I Cancel & Reactivate Alarm

> In Step 1 (highlight an Alarm), (3)[Menu] — Select an item — YES
® Cancel or reactivate an alarm entry as required.

@ Highlight an entry = (@) to reactivate/cancel Alarm.

Snooze Function
If ON, press any key; Snooze window appears. To cancel Alarm, press (=).

@ Alarm tone does not sound when Privacy Key Lock or Personal Data
Lock is set. However, settings can be changed even while Personal Data
Lock is set (C%P.12-6).

sjoo) ﬂ



Calculator Notepad

@ Calculates up to 10 digits. Save up to 20 notes.

Main Menu b Tools p> Calculator .
I Saving a Note

Operation Assigned key ] Calculator
Number (0 - 9)

Main Menu p> Tools »> Notepad

8

+ Notepad 1/2

<Not Recorded>

[1[<Not Recorded>
[EI<Not Recorded>

@ Select a saved note to view content.

[El<Not Recorded>
EI<Not Recorded>

X (@)[Edit] to edit.

[H<Not Recorded>
[E<Not Recorded>

2 Enter text

[Ed<Not Recorded>
[EI<Not Recorded>

@ Up to 256 double-byte or 512 single-byte
characters can be entered.

El<Not Recorded>
[<Not Recorded>

Decimal point

EI<Not Recorded>
EI<Not Recorded>

%

HlG]Elol3lEHali=lIES

W <Not Recorded>

Clear

sjoo] a

Zse lect
Example: -
-17+428.5=11.5 Notepads Window
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I Notepad Functions

In Notepad list window, press (x7[Menu] for following

operations.
Item Operation/Description
Edit Edit a saved note
Compose Insert Notepad text to message (C%From Step 2 on
message P.14-4)

Edit schedule

Copy a note to Schedule to create a Calendar event
> Schedule — Save a new note (Z3From Step 2 on
P.13-2)

Add shortcut
icon

Create a shortcut (C%P.1-25)

Send Ir data (%P.11-3)

Send all Ir *P11-3)

data

IC transmission (C%P.11-5)

AlliC ([C%P.11-5)

transmission

Copy to Copy a note to microSD Card
microSD >YES

® To display data on microSD Card: £3P.10-20

Notepad Info

Display entry date, latest modified date and category of
note

Category > Select a category

® When no category applies, select None.
Delete this > YES
Delete > Check notes = (=2)[Finish] = YES
selected
Delete all > Enter Phone Password = YES

Osaifu Keitai®

"Osaifu-Keitai®" is a range of IC Card-based services used
by Osaifu-Keitai® compatible handsets. Make purchases

using e-money or e-ticketing. Hold handset up to a reader/

writer to pay for your purchase.

M Osaifu-Keitai® Terms

Osaifu- A contactless IC Card technology to read/write data by
Keitai® holding an IC card up to a reader/writer

IC Card An IC chip embedded in Osaifu-Keitai®-compatible handsets
Lifestyle- | Applications to use Osaifu-Keitai®. Some applications are
Appli preinstalled.

Precautions

@ Data saved in IC Card vary by service content and usage history.
Procedures to delete IC Card data vary by Lifestyle-Appli. Contact
Osaifu-Keitai® service providers for details.

@ SoftBank is not liable for damages from accidental loss or alteration of IC

Card data or settings.

@ |C Card data can be misused if your Osaifu-Keitai® compatible handset is

lost or stolen. SoftBank is not liable for any resulting damages.
@ Downloading Lifestyle-Appli and using applications may incur high
packet transmission charges.

3
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Getting Started

I Downloading Lifestyle-Appli
Downloading Lifestyle-Appli —

Download Lifestyle-Appli via Internet website.

Main Menu p> Tools p> Osaifu-Keitai p> Lifestyle-Appli
1 Download = YES
- . .
Registration/Settings 7 Select a Lifestyle-Appli
Activate Lifestyle-Appli to complete registration or customize
settings.

@ Lifestyle-Appli is saved to Data Folder.
® Make deposit into account, check payment records or balance, etc.

I Activating Lifestyle-Appli

' ) . @ Lifestyle-Appli cannot be activated during a call or while another
@ Keep a copy of service passwords/customer service contact, etc. in a 1 Appli is active
separate place. ' '

Main Menu p> Tools b Osaifu-Keitai p> Lifestyle-Appli
1 Select a Lifestyle-Appli

2 Toexit, (=) - Stopped

sjoo] a

® Alternatively, Main Menu p> S! Appli »> Osaifu-Keitai
» Lifestyle-Appli
or

Main Menu p> Data Folder p- Lifestyle-Appli
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I Reader/Writer Transactions

® Complete registration/settings and charge your account beforehand.
® There is no need to activate a Lifestyle-Appli during transaction.

1 Hold £ logo up to reader/writer

@ \When IC Card Notification Light is ON,
Notification Light illuminates (%P.18-10).
@ Hold handset parallel to reader/writer.
Try moving handset around if recognition is
slow.
® Check scan result on reader/writer display.
@ Osaifu-Keitai® can be used during a call or
Internet transmission (May require extra
time.).

£ logo

o,

L

@ Data may be unreadable if a metal object, etc. is between /) logo and
reader/writer.

® Even though Osaifu-Keitai® is available while handset is off, Lifestyle-
Appli does not activate. However, if battery is left uncharged after
warning tone sounds, Osaifu-Keitai® may become disabled. Charge
battery beforehand.

@ \When handset is held up to reader/writer, handset may show a message
or vibrate depending on service. S! Appli, Messaging or Internet may
also activate automatically. To avoid such cases, set the functions not to
activate during transactions (%P.18-26).

P eccccccccccccocccccccoe

@ITTD @Disable Handset Response to Commands from Reader/Writer
(C%P.18-26)

3
S
w

-
w

13-11



I IC Card Lock
Activating IC Card Lock

<Default> OFF
® While set, %; appears in Standby.

1 Pressand hold = Enter Phone Password

@ Repeat the step as required to unlock.

® Alternatively, Main Menu p> Tools p> Osaifu-Keitai
» IC Card Settings »> IC Card Lock or Main Menu p> Settings
p Security > I1C Card Lock

sjoo] ﬂ
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Remote Lock

<Default> OFF
® Save up to three phone numbers to enable Remote Lock.

Main Menu p> Tools > Osaifu-Keitai > IC Card Settings
» Remote Lock

1 Enter Phone Password = ON

2 Select an item (See below)

Item Operation/Description

Numbers to Save numbers to activate Remote Lock

Permit > <Not Recorded> — Enter phone numbers =
(=)[Return]

® To save numbers from Phone Book/Incoming Call

Logs or to use a payphone number: (37)[Menu] -
Refer to or Payphone

# of Incoming  Specify the number of incoming calls for activating IC

Call Card Lock

> Enter a number

3 ([=[set]



Activating Remote Lock

(MCall 941P from one of the specified numbers (Send Caller ID)

(@Hang up after 941P receives the call

(®Repeat M-@ until specified number of incoming calls is reached (within
three minutes)

® After specified number of incoming calls, IC Card Lock is set and a
message informs you IC Card Lock is activated.

_Note |

® When setting IC Card Lock, call 941P from the same specified phone
number. Incoming calls from different phone numbers cannot be
counted.

@ Specified incoming calls may not be counted when Call Forwarding is
active.

® Remote Lock is not available when ring time for Answer Phone is set to
0 or Driving Mode is active.

® When Answer Phone activates, counted number of incoming calls are
reset.

Dictionary (Japanese)

Use & —% A TOOL<FZE> to access dictionaries (32 #Z/\

A0 - MSEEEE and 2 HEEES).
® 7 —%5 A TOOL<EE> is an S! Appli.

Main Menu p> Tools p> Dictionary

1 Read & (disclaimer) = OK
T —%5 A TOOL<EFE> activates.
® To disable &
Uncheck 77 Z U EBIFFIC B IC 2w T Do (Always show
disclaimer when accessing dictionaries)

2 () - Enter aword

Search results appear.
@ To scroll pages: (99
@ To switch dictionaries: CTD/(3)
(In Horizontal Open Position: CTO/(7))
® To search again: ()[R 3]
(In Horizontal Open Position: GO))

3 Select a word
Definition appears.

4 Toend, (=) - Stopped

@ While Dictionary application is active, press (&)[ % = 2—] for useful
functions.

® Word search is available while composing messages or viewing sent/
received messages or website contents (C%P.14-8, P14-23, P.15-13).
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Sound Recorders
IVoice Recorder

Set recorded sounds for ringtones.
@ Record for about 60 seconds each.

Main Menu p> Tools p> Sound Recorders > Voice Recorder
1 YES

Recording starts.

2 (@)[Stop)/@7a)/(=) (= OK) to stop recording

Recorded sounds are saved in Ring Songs&Tones folder.

13-14

I Voice Announce

Set recorded sound for on hold tone/holding tone, Alarm,

Calendar event alarm, Tasks alarm, ringtones, Answer Phone

message, Timer Watching (Digital TV), Ring Songs&Tones

Play List.

@ Record only one item for about 15 seconds.

® Select Voice Announce in individual window to set Voice Announce as
specific tone.

Main Menu p> Tools > Sound Recorders p> Voice Announce

1 Record

Recording starts.
Tone beeps five seconds before recording ends.

2 (@JIStop] to end recording
Tone beeps twice and previous screen returns.
® To play back: Play
® To delete: Erase = YES



Bar Code Reader

Scan barcodes (JAN) or QR Codes with built-in camera.
Access websites, send messages, etc. from QR Codes.

JAN Codes
JAN Code is a one-dimensional bar code denoting numerals with bars
and spaces of different widths.

QR Codes [m] yre[w]
QR Code is a two-dimensional bar code containing h"".
information. = i

=]

Example: SoftBank mobile phones

I Scanning Barcodes

@ Up to five items can be saved.
@ For split data, up to 16 QR Codes can be scanned at a time and saved as
one item.

Main Menu p> Tools p> Bar Code Reader > Scan Barcodes

1 Frame barcode in the center of Display

® To adjust Display brightness: (7)[Menu] = Brightness -
Adjust to -3 (dark) - +3 (light)

® To zoom: ()

® To use Focus Lock: (@)

2 (eJistart]
Scanning starts, and scanned results appear when completed.

@ For split data, OK = Repeat Step 1 and 2
® To use scanned data: £%Step 2 on P.13-16

3 (¥[Menu] -+ Save result - OK

® To start over: - YES

@ Handset cannot read barcodes or two-dimensional codes other than
JAN/QR Codes.
® Some barcodes may be unreadable.

@ Barcode recognition may be slow. Hold handset steady while scanning.

@ Barcodes may not be correctly read owing to scratch, dirt, damage,
quality of printed material, light reflection, or QR code version.

sjoo) a
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IViewing/Editing Scanned Data

Main Menu p> Tools p> Bar Code Reader ) Saved Data List
1 View

Select an item

Edit Title

Highlight an item = (x7)[Menu] — Edit title - Edit
M Delete Saved Data

> In Step 1, (highlight an item =) (7)[Menu] = Delete — Delete this
or Delete all (= For Delete all, enter Phone Password) = YES

13-16

I Using Scanned Data

Main Menu p> Tools p> Bar Code Reader ) Saved Data List

1 Select an item

2 (¥7)[Menu] = Select an item (See below)

Item Operation/Description
Save result  Save scanned results
Display list  Display Saved Data List
Internet Access website
> Yahoo! Keitai or PC Site Browser = YES
® Alternatively, select the URL.
Compose Insert address to message recipient field (C%From Step 4
message on P.14-4)
® Alternatively, select the address.
Dialing Call selected phone number
> Select a dialing method = Dial
® Alternatively, select phone number to dial.
Add to Save scanned results to Phone Book (Z%From Step 2 on
Phone Book P 4-5)
Add Save URL to Bookmark
bookmark > YES - (@)[0K]
Copy Copy selected characters to another place (From Step 2

on P.3-10)
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